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JavaScript Object
Specification

Introduction

JavaScript, the scripting language developed by Netscape Communications, enables you to
easily create interactive Web pages.

JavaScript v1.2 comes with six predefined classes: Boolean, Number, Date, Math, String, and
Array. As part of the integration with Adobe® Acrobat® Forms, we have defined additional
classes and objects to allow access to portions of the PDF file.

This document describes these classes, as well as details the load and execution of JavaScripts in
the Adobe Acrobat environment. Of particular note is the section titled Field Object which
handles all processing of Acrobat Form fields including their formatting, calculation, and
validation.

The intended audience of this document is assumed to be familiar with Adobe Acrobat, the
Acrobat Forms plug-in and the Adobe Acrobat plug-in API.

Other useful documents

For more information on JavaScript, please see Netscape’s JavaScript Reference Manual for
details on JavaScript objects and on language syntax.

Portable Document Format Reference Manual, version 1.2 or later, describes the PDF
representation of a form and its fields. Appendix H, describes the Forms Data Format, which is
one of the formats of data exported from an Acrobat form. This document is available with the
Adobe Acrobat Plug-ins SDK CD-ROM or on the Adobe Web site http://www.adobe.com/
supportservice/devrelations/PDFS/TN/PDFSPEC.PDF.

Technical Note #5166, Acrobat Viewer plug-in API Overview. Gives an overview of the objects
and methods provided by the Acrobat viewers’ plug-in API. This document is available with the
Adobe Acrobat Plug-ins SDK CD-ROM or on the Adobe Web site http://betal.adobe.com/ada/
acrosdk/DOCS/VWRPIOVR.PDF.

Technical Note #5167, Acrobat Viewer plug-in APl Development. Tells how to develop Acrobat
viewer plug-ins on the various platforms available. This document is available with the Adobe
Acrobat Plug-ins SDK CD-ROM or on the Adobe Web site http://betal.adobe.com/ada/
acrosdk/DOCS/VWRPIDEV.PDF
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Technical Note #5168, Acrobat Viewer plug-in APl On-Line Reference. Describes in detail the
objects and methods provided by the Acrobat viewer’s plug-in API. This document is available
with the Adobe Acrobat Plug-ins SDK CD-ROM or on the Adobe Web site http://
betal.adobe.com/ada/acrosdk/DOCS/VWRPIREF.PDF.

JavaScript Locations and Loading

JavaScripts can work with Acrobat Forms on a variety of levels such as; the plug-in level,
document level, and field level. These levels restrict the type of processing that can occur and
are loaded at different times. We will discuss how these all interact.

Plug-in folder level

JavaScripts can work as individual files with the “.js” extension. These files are executed, in no
particular order, when the JavaScript engine is initialized. The Acrobat Forms plug-in looks for
these files on Microsoft Windows and UNIX platforms in the Acrobat plug-ins folder. On the
Apple Macintosh the files are in a subfolder of the plug-ins folder called JavaScript. Variables
and functions that might be generally useful to the application should be kept at the plug-in
level. The standard Acrobat Forms implementation comes with two plug-in level files: Aform.js,
which contains built-in, pre-canned functions; and AFString.js, which contains the language
dependent strings needed by Aform.js.

The document level

By using the Adobe Acrobat Exchange menu item Tools->JavaScripts-> Document Scripts..., the
user can add, modify, or delete document level scripts. These scripts should be function
definitions that are generally useful to the document but are not applicable outside the
document. Document level scripts are executed after the document has opened and after the
plug-in level scripts are loaded. Document level scripts are stored within the PDF document.
Therefore, the forms programmer should make every effort to package scripts as effectively as
possible.

The field level

The user can add scripts to a form field definition using a dialog box in the form editing tool.
(see Event Processing section below). These scripts are executed as the events occur (e.g.
mouse up or calculate). Scripts that are field specific should be created at this level. Usually
these scripts validate, format, or calculate field values.

Unlike plug-in folder scripts, document level and field level scripts are stored within the PDF
document and therefore the forms programmer should make every effort to package his scripts
as effectively as possible (e.g. code reuse) at the various levels for performance and file size
reasons.
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Acrobat Forms JavaScript Object Model

Acrobat Forms defines an object model on top of JavaScript 1.2. These objects are only defined
within the Adobe Acrobat realm and are specific to Acrobat Forms. They basically mirror the
Acrobat Forms components and give the forms developer a way to access these components
programmatically in order to query and change their properties. In addition to defining forms
specific objects, there are additional generic objects that allows the developer to access the
underlying document and perform certain actions on it.
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Field Object

The Field object represents an Acrobat form field (that is, a field created using the Acrobat
form tool). In the same manner that an author might want to modify an existing field’s
properties like the border color or font, the Field object gives the JavaScript user the ability to
perform the same modifications.

Field Access from JavaScript

Before a field can be accessed, it must be “bound” to a JavaScript variable through a method
provided by the Doc Object methods interface. More than one variable may be bound to a field
by modifying the field’s object properties or accessing its methods. This affects all variables
bound to that field.

var f = doc.getField("Total");

This example allows the script to now manipulate the form field Total via the variable “f”.

Form Field Hierarchies

Form fields typically have names like FirstName, LastName, etc. This naming convention is
referred to as flat names. For many form applications, this flat hierarchy of names is sufficient
and works well. The problem with using flat names is that there is no association between the
fields.

Form field names can be more useful by creating a hierarchal structure. For example, if we
change FirstName to Name.First and LastName to Name.Last we form a tree of fields. The
period (“.”) separator used in Acrobat Forms and denotes a hierarchy shift. The Name portion
of these fields is the parent, and First and Last become the children. While there is no limit to
the depth a hierarchical name can be constructed it is important that the hierarchy remain
manageable.

This hierarchy can be useful in a number of ways. It can speed up authoring and ease
manipulation of groups of fields in JavaScript. In addition, a form field hierarchy can improve
the performance of forms applications when there are many fields in the document.

Form Field Hierarchies with JavaScript

Using our original flat names FirstName, MiddleName and LastName, imagine that we want to
change the background color of these fields to yellow (to indicate missing data, or emphasize
an important point). We would need two lines of JavaScript code for each field:

var nane = this.getField("FirstNane");
nane. bgCol or = col or. yel | ow;

name = this.getField("Mddl eNane");
nane. bgCol or = col or. yel | ow;
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name = this.getField("Last Nane");
nane. bgCol or = col or. yel | ow;

With our hierarchy of Name.First, Name.Middle and Name.Last above (and perhaps, Name.Title
if used), we can change the background color of these fields with just two lines of code instead
of six:

var name = this.getfield("Name”);
name.bgColor = color.yellow

When using this hierarchy within a JavaScript, remember you can only change appearance
related properties of the parent field and that appearance changes propagate to all children.
You cannot change the field’s value. For example if you try the following script:

var name = this.getField(“Name”);
name.value = “Lincoln”;

the script will fail. Name is considered a parent field. You can only change the value of terminal
fields (i.e. a field that does not have children like Last or First). The following script executes
correctly:

var first = this.getField(“Name.First”);

var last = this.getField(“Name.Last”);

first.value = “Abraham”;

last.value = “Lincoln”;

Field Properties

The following is a chart of field property names used by Acrobat with Javascript and the field
properties that are available:

Field Property Type Text Combo List Push Check | Radio Read Write
Name Field Box Box Button Box Button | Access | Access
alignment String O O O
bgColor Array N U U U U U N U
borderColor | Array O O O O O O O O
borderStyle | String O O O O O O O O
borderWidth | Integer O 0 O O O O O O
calcOrderind | Integer O O O O
ex
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Field Property Type Text Combo List Push Check | Radio Read Write
Name Field Box Box Button Box Button | Access | Access
charLimit Integer 0 0 a
defaultvalue | String O O O O O O O
delay Boolean O O O O O O O O
doc Object O O O O O O O
editable Boolean 0 0 0
fgColor Array O O O O O O O O
hidden Boolean O O O O O O O O
highlight String O O O
multiline Boolean O O
name String O a a a 0 0 O
numltems Integer O O O
password Boolean O O
print Boolean 0 a a a a a 0 a
readonly Boolean O O O O O O O O
required Boolean O O O O O O O
style String 0 0 ] 0
textFont String O O O O O O
textSize Integer O O O O O O O O
type String 0 a a a a a 0
userName String O O O O O O O O
value Various O O O O O O O
alignment
Type: String Fields: Text Access: R/W

Acrobat Forms - JavaScript Object Specification
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This property determines how the text is laid out within the text field. Valid alignments
include left, center, and right.

var f = this.getField("M/Text");

f.alignment = "center”;
bgColor
Type: Array Fields: All Access: R/W

This property specifies the background color for a field. The background color is used to fill
the field’s rectangle. Values are defined by using transparent, gray, RGB or CMYK color. Refer

to the Color Arrays section for information on defining color arrays and how values are used
with this property.

var f = this.getField("MField");
if (f.bgCol or == color.red)
f. bgCol or = col or. bl ue;

el se
f. bgCol or = color. yell ow;

borderColor

Type: Array Fields: All Access: R/W

This property specifies the border color for a field. The border color is used to stroke the
field’s rectangle with a line as large as the border width. Values are defined by using trans-

parent, gray, RGB or CMYK color. Refer to the Color Arrays section for information on
defining color arrays and how values are used with this property.

borderStyle

Type: String Fields: All Access: R/W

This property specifies the border style for a field. Valid border styles include solid, dashed,
beveled, inset, and underline. The border style determines how the border for the rectangle is

drawn.
» The solid style strokes the entire perimeter of the rectangle with a solid line.
* The dashed style strokes the perimeter with a dashed line.

» The beveled style is equivalent to the solid style with an additional beveled (pushed-out
appearance) border applied inside the solid border.

13
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* The inset style is equivalent to the solid style with an additional inset (pushed-in
appearance) border applied inside the solid border.

* The underline style strokes the bottom portion of the rectangle’s perimeter.

The border object is a static convenience constant that defines all the border styles of a field.
The following example illustrates how to set the border style of a field to solid:

var f = this.getField("MField");
f.borderStyle = border.s; /* border.s evaluates to "solid" */

The following chart defines the borderStyle property and its associated keywords:

Type Keyword
solid border.s
beveled border.b
dashed border.d
inset border.i
underline border.u
borderWidth
Type: Integer Fields: All Access: R/W

This property specifies the thickness of the border when stroking the perimeter of a field’s
rectangle. If the border color is transparent, this parameter has no effect except in the case of
a beveled border. You can set the borderWidth property in JavaScript by using the integer
values below:

Border Type Key Value
none 0
thin 1
medium 2
thick 3

For example:

// Change the border width of the Text Box to nediumthickness
f.borderWdth = 2

Acrobat Forms - JavaScript Object Specification 14



The default value for borderWidth is “1” (thin). Any integer value can be used. However,
values beyond “5” distort the field’s appearance. Using this property is the same as using the
Acrobat Forms Field Properties -> Appearance dialog box.

calcOrderindex

Type: Integer Fields: Text, Combo Box Access: R/W

Use this property to change the calculation order of fields in the document. When a comput-
able Text or Combo Box field is added to a document, it is added to the end of the document
and the field’s name is placed in the calculation order array. The calculation order array deter-
mines the order fields are calculated in the document (see The "calculation order array”
section for more information about calculation order arrays). The calcOrderindex property
works similarly to the Calculate tab used by the Acrobat Exchange Form tool. Note the
following example:

var a = this.getField("new tent);
var b = this.getField("oldltent);
a.cal crderlndex = b.cal cOrderlndex + 1;

In this example, the Doc Object method getField, gets the ‘newltem’ field that was added after
‘oldItem’ field. It then changes the calcOrderindex of the ‘oldItem’ field so that it is calculated
before ‘newltem’ field.

charLimit

Type: Integer Fields: Text Access: R/W

This property limits the number of characters that a user can type into a text field.

defaultValue

Type: String Fields: All but Button Access: R/W

This property exposes the default value of a field. This is the value that the field is set to when
the form is reset.

delay
Type: Boolean Fields: All Access: R/W
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This property delays the redrawing of a field’s appearance. It is generally used to buffer a
series of changes to the properties of the field before requesting that the field regenerate its
appearance. Setting the property to true forces the field to wait until delay is set to false. The
the update of its appearance takes place, redrawing the field with its latest settings.

// Get the MyCheckBox field
var f = this. getField("M/CheckBox");
// set the del ay and change the fields properties
// to bevel ed edge and medi um t hi ckness |i ne.
f.delay = true;
f. border Styl e = border. b;
f.borderWdth = 2
// force the changes now
f.delay = fal se;

doc

Type: Object Fields: All Access: R

This property defines the document the field belongs to. Its value is the Doc Object or the
"this" Object . Please refer to the Doc Object section for more details.

editable
Type: Boolean Fields: Combobox Access: R/W

Combo boxes can be editable, that is, the user can type in a selection. This property deter-
mines whether the user can type in a selection or must choose one of the provided selections.

var f = this.getField("MConboBox");
f.editable = true;

fgColor
Type: Array Fields: All Access: R/W

This property determines the foreground color of a field. It represents the text color for text,
button, or list box fields and the check color for check box or radio button fields. Values are
defined the same as bgColor property. Refer to the Color Arrays section for information on
defining color arrays and how values are set and used with this property.

var f = this.getField("MField");
f.fgCol or = col or. red;
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hidden
Type: Boolean Fields: All Access: R/W

This property controls whether the field is hidden or visible to the user. It the value is true
the field is visible, false the field is invisible. The default value for hidden is false.

// Set the field to hidden
var f = this.getField("MField");
f. hidden = true;

highlight
Type: String Fields: Button Access: R/W

This property defines how a button reacts when a user clicks it. The four highlight modes
supported are none, invert, push and outline.

* The none highlight does not indicate visually that the button has been clicked.

» The invert highlight causes the region encompassing the button’s rectangle to invert
momentarily.

» The push highlight displays the down face for the button (if any) momentarily.
» The outline highlight causes the border of the rectangle to invert momentarily.

The ‘highlight’ object defines all the characteristics that a button can have. Use it in your
scripts to access the highlight of choice. The following chart shows the highlight object and its
associated keywords:

Type Keyword

none highlight.n
invert highlight.i
push highlight.p
outline highlight.o

The following example sets the highlight property of a button to “invert”.

// set the highlight npde on button to invert
var f = this.getField("MButton");
f.highlight = highlight.i;
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multiline

Type: Boolean Fields: Text Access: R

This read-only property determines how the text is wrapped within the field. Text fields can
be single line (clip to field boundaries) or multi-line (wrap to field boundaries).

name

Type: String Fields: All Access: R

This property allows you to access the fully qualified field name of the field as a string object.

var f = this.getField("MField");
consol e. println(f.nane);

numlitems
Type: Integer Fields: Combo & Listbox Access: R

The number of items in the combo or list box.

password

Type: Boolean Fields: Text Access: R

This property causes the field to display asterisks for the data entered into the field. Upon
submission, the actual data entered is sent. Fields that have the password attribute set will not
have the data in the field saved when the document is saved to disk.

print
Type: Boolean Fields: All Access: R/W

This property determines whether a given field prints or not. Set the print property to true to
allow the field to appear when the user prints the document, set it to false to prevent printing.
This property can be used to hide control buttons and other fields that are not useful on the
printed page.

var f = this.getField("M/Field");
f.print = fal se;

readonly

Type: Boolean Fields: All Access: R/W
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This property sets or gets the read-only characteristic of a field. If a field is read-only, the user
can see the field but cannot change it.

required
Type: Boolean Fields: All but Button Access: R/W

This property sets or gets the required characteristic of a field. If a field is required its value
must be non-null when the user clicks a submit button that causes the value of the field to be
posted. If the field value is null, the user receives a warning message and the submit does not
occur.

var f = this.getField("M/Field");
f.required = true;

style
Type: String Fields: Checkbox, Radio Button Access: R/W

This property allows the user to set the style of a check box or a radio button, that is, sets the
glyph used to indicate that the check box or radio button has been selected. Valid styles
include check, cross, diamond, circle, star, and square. The following defines the style proper-
ties and the associated keywords:

Style Keyword
check style.ch
Cross style.cr
diamond style.di
circle style.ci
star style.st
square style.sq

The following example illustrates the use if this property and the style object:

var f = this.getField("MCheckbox");
f.style = style.ci;

textFont

Type: String Fields: Text, Combo, List & Button Access: R/W
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The textFont property determines the font that is used when laying out text in a text field,
combo box, list box or button. Valid fonts are defined as properties of the “font” object as

follows:
Text Font Keyword
Times-Roman font.Times
Times-Bold font.TimesB
Times-Italic font.Timesl
Times-BoldItalic font.TimesBI
Helvetica font.Helv
Helvetica-Bold font.HelvB
Helvetica-Oblique font.Helvl
Helvetica-BoldOblique font.HelvBI
Courier font.Cour
Courier-Bold font.CourB
Courier-Oblique font.Courl
Courier-BoldOblique font.CourBl
Symbol font.Symbol
ZapfDingbats font.ZapfD

The following example illustrates the use of this property and the font object.

// set the font of M/Field to Hel vetica
var f = this.getField("MField");
f.textFont = font. Hel v;

textSize

Type: Integer Fields: All Access: R/W

This property determines the text size in points that is used in all controls. In combo box and
radio button fields, the text size determines the size of the check. Valid text sizes include zero
and the range from 4 to 144 inclusive. A text size of zero means that the largest point size that
can still fit in the field’s rectangle should be used (in multi-line text fields and buttons this is
always 12 point).
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// set the text size of M/Field to 28 point
var f = this.getField("MField");
f.textSize = 28;

type
Type: String Fields: All Access: R

This read-only property returns the type of the field as a string. Valid types that are returned
include text, button, combo box, list box, check box, and radio button.

userName
Type: String Fields: All Access: R/W

This property returns the user name of the field as a string.

value
Type: Various Fields: All But Button Access: R/W

This property gets the value of the field data that the user has entered. Depending on the type
of the field, the value may be a string, date, or number. Typically, the value is used to create
calculated fields.

var oil = this.getField("G1l");
var filter = this.getField("Filter");
event.value = (oil.value + filter.value) * 1.0725;

In this example, the value of the field being calculated is set to the sum of the oil and filter
fields and multiplied by the state sales tax. Value is perhaps the most important of all the field
properties.

Field Methods

buttonimporticon

Parameter: none
Returns: nothing

This method imports the appearance of a button from another PDF file. It prompts the user
to select a PDF file available on the system.
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clear

Parameters: none
Returns: nothing

This method clears all the values in a list box or combo box.

// Cear the field M/Listbox
var f = this.getField("M/ListBox");
f.clear();

getArray

Parameters: None
Returns: an array of fields.

This function returns an array of terminal children fields (i.e. fields that can have a value) for
a parent field. This method can be particularly useful for doing field calculations in tables
where a parent field value is the sum of all of its children. To understand more about field
name and hierarchies, please see the section on Form Field Hierarchies.

// f has 3 children: f.v1, f.v2, f.v3
var f = this.getField("f");

var a = f.getArray();

var v = 0.0;

for (j =0; j < a.length; j++)
v += afj]. val ue;
// v contains the sumof all the children of field "f"

getltemAt

Parameters: nlndex
Returns: internal value in an item in a list or combo box

This function gets the internal value of an item in a combo box or a list box. The parameter
nindex is the index of the item in the list to obtain. If nindex is set to -1, it returns the value

of the last item in the list. The getltemAt function returns the exported or internal value of
the item at nindex in the combo box or list box.

// returns value of first itemin list |
var a = this.getField("M/ListBox");
var v = a.getltemAt(0);
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insertitemAt

Parameters: cName, cExportValue, [nIndex]
Returns: nothing

This function inserts a new item into a combo box or a list box. cName is the index at which
to insert the item in a list box or combo box. cExportValue is the string export value of the
item i.e. internal value of the item being inserted. nindex is the index in the list to insert the
item at. If nindex is 0, cName is inserted at the top of the list. If nindex is -1, cName is
inserted at the end of the list. The default value for nindex is 0.

var | = this.getField("l"); /* 1| is alist box */
var v =l.insertltemAt("sant’, "s", 0); /* inserts samto top of list | */
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Event Object

All JavaScripts are executed as the result of a particular event (also referred to as a trigger).
Acrobat Forms accepts the following events and executes any scripts that are specified for these
events: mouse enter, mouse down, mouse up, mouse exit, keystroke, selection change, committed,
format, validate, and calculate. It is important to JavaScript writers to know what these events
are and when and what order they are processed.

Event Processing

The "mouse enter" Event

The mouse enter event is triggered when a user moves the mouse pointer inside the rectangle of
a field. This is the typical place to open a text field to display help text, etc.

The "mouse down" Event

The mouse down event is triggered when a user starts to click on a form field and the mouse
button is still down. It is advised that you perform very little processing (i.e. play a short
sound) during this event. A mouse down event will not occur unless a mouse enter event has
already occurred.

The "mouse up" Event

The mouse up event is triggered when the user clicks on a form field and releases the mouse
button. This is the typical place to attach routines such as the submit action if a form. A mouse
up event will not occur unless a mouse down event has already occurred.

The "mouse exit" Event

The mouse exit event is the opposite of the mouse enter event and occurs when a user moves the
mouse pointer outside of the rectangle of a field. A mouse exit event will not occur unless a
mouse enter event has already occurred.

The "keystroke" Event

The keystroke event occurs whenever a user types a keystroke into a text box or combo box field.
JavaScript may want to limit the type of keys allowed (i.e. a numeric field might only allow
numeric characters).

Acrobat Forms - JavaScript Object Specification 24



The "selection change™" event

The selection change event is similar to the keystroke event. This is used for list and combo boxes
fields. The value is changed automatically as the item is selected from the list or combo box.

The "committed" Event

Regardless of field type, the user interaction with the field may produce a new value for that
field. After the user has either clicked outside a field, tabbed to another field, or pressed the
enter key, the user is said to have committed the new data value.

The "validate" Event

A validate event is generated for a field so that a JavaScript can verify that the value entered was
correct. If the validate event is successful, the next event triggered is the calculate event.

The "calculate" Event

The calculate event causes all fields that have a calculation script attached to them to be
executed. All fields that depend on the value of the validated field will now be re-calculated.
These fields may in turn generate additional validate, calculate, and format events.

The "calculation order array™

Another important part of event processing is understanding how fields are calculated in the
document. This is accomplished by the calculation order array. The calculation order array
contains a list of all the calculated fields in a document. This array determines the order
calculations are performed on individual fields in a particular document. To change the
calculation order of a calculated field, use the Tools->JavaScript->Set Calculation Order... menu
item in Adobe Acrobat. The dialog box will prompt you for the calculation order.

The "format" Event

Once all dependent calculations have been performed the format event is triggered. This event
allows the attached JavaScript to change the way that the data value appears to a user (also
known as its presentation or appearance). For example, if a data value is a number and the
context in which it should be displayed is currency, the formatting script can add a dollar sign
($) to the front of the value and limit it to two decimal places past the decimal point.
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Event Object Properties

target
Type: Object Event: All events Access: R

This property contains the target object that triggered the event. In all mouse events it is the
field object that triggered the event. In other events like page open and close it is the docu-

ment or "this" Object.

shift
Type: Boolean Event: Keystroke, Mouse events Access: R

This property is a boolean that specifies whether the shift key is down during a particular
event.

modifier

Type: Boolean Event: Keystroke, Mouse events Access: R

This property is a boolean that specifies whether the modifier key is down during a particular
event. The modifier key on the Microsoft Windows platform is Control and on the Macintosh
platform is Option or Command. The modifier property is not supported on UNIX.

change

Type: String Event: Keystroke, Selection ChangeAccess: R/W

This property specifies the change in value that the user has just typed. The change is replace-
able such that if the JavaScript wishes to substitute certain characters, it may.

selStart
Type: Integer Event: Keystroke Access: R/W

This property specifies the starting position of the current text selection during a keystroke
event.

selEnd
Type: Integer Event: Keystroke Access: R/W
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This property specifies the ending position of the current text selection during a keystroke
event.

rc

Type: Boolean Event: Keystroke, Validate Access: R/W

This property is used for validation. It indicates whether a particular event in the event chain
should succeed. Set rc to false to prevent a change from occurring or a value from commit-
ting. By default rc is true.

For each event, except the mouse related events, the static event object is populated with the
following data. In most events, it is important for JavaScript to set the rc (return code) prop-
erty to indicate that the event can proceed.

value

Type: Various Event: Validate, Calculate, Format, SelChangeAccess: R/W

For the validate event, value is the value that the field contains when it is committed. The
current field value is the value property for the field. For example, the following JavaScript
verifies that the field value is between zero and 100.

Example:

if (event.value < 0 || event.value > 100) {
app. beep(0);
app. alert("lnvalid value for field " + event.target. nane);
event.rc = fal se;

}

For a calculate event, JavaScript should set this property. This is the value that the field
should take upon completion of the event. For example, the following JavaScript sets the
calculated value of the field to the value of the SubTotal field plus tax.

var f = this.getField("SubTotal ");
event.value = f.value * 1. 0725;

For a format event, JavaScript should set this property. This is the value used when generating
the appearance for the field. By default, it contains the value that the user has committed. For
example, the following JavaScript formats the field as a currency type of field.

event.value = util.printf("$%2f", event.value);
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willCommit

Type: Boolean Event: Keystroke Access: R

Use this property to verify the current keystroke event before the data is committed. This is
useful to check the target form field values and for example verify if character data instead of
numeric data was entered. JavaScript sets this property to true after the last keystroke event
and before the field is validated.

Example:

var val ue = event. val ue
if (event.wil| Commit)
// Final value checki ng.
el se
// Keystroke | evel checking.

For more examples of using willCommit, refer to the Acrobat Forms JavaScript application
(Aform.js) in your Acrobat plug-ins directory.
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Color Arrays

A color is represented in JavaScript as an array containing 1, 2, 4, or 5 elements corresponding
to a transparent, gray, RGB, or CMYK color space, respectively. The first element in the array is
a string denoting the color space type. The subsequent elements are numbers that range
between zero and one inclusive. The following table illustrates this:

Color Space String # of Additional
Elements

Transparent “T” 0

Gray “G” 1

RGB “RGB” 3

CMYK “CMYK” 4

For example, the color red can be represented as [“RGB” 1 0 0].

Invalid strings or insufficient elements in a color array cause the color to be interpreted as the
color black.

A transparent color space indicates a complete absence of color and will allow those portions of
the document underlying the current field to show through.

Colors in the gray color space are represented by a single value—the intensity of achromatic
light. In this color space, 0 is black, 1 is white, and intermediate values represent shades of gray
(i.e. “.57, “.7" etc.).

Colors in the RGB color space are represented by three values: the intensity of the red, green,
and blue components in the output. RGB is commonly used for video displays because they are
generally based on red, green, and blue phosphors.

Colors in the CMYK color space are represented by four values. These values are the amounts
of the cyan, magenta, yellow, and black components in the output. This color space is
commonly used for color printers, where they are the colors of the inks traditionally used in
four-color printing. Only cyan, magenta, and yellow are necessary, but black is generally used
in printing because black ink produces a better black than a mixture of cyan, magenta, and
yellow inks, and because black ink is less expensive than the other inks.

Color Objects

The Color object is a convenience static object that defines the basic colors. These colors are
accessed in JavaScripts via the color object. Use this object whenever you want to set a property
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or call a method that require a color array. The color object defines the following colors and
there associated keywords:

Color Object Keyword
Transparent color.transparent
Black color.black
White color.white

Red color.red

Green color.green

Blue color.blue

Cyan color.cyan
Magenta color.magenta
Yellow color.yellow

Example:

/1 This exanple sets the text color of the field to red
/1 if the value of the field is negative, else it sets it
/1 to black.
var f = event.target; /* field that the event occurs at */
if (event.value < 0)

f.fgCol or = col or. red;
el se

f.fgCol or = col or. bl ack;

The color object and all its properties are defined in AForm.js.
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App Object

The App object is a static JavaScript object that defines a number of Acrobat specific functions
plus a variety of utility routines and convenience functions.

App Object Properties

calculate

Type: Boolean Access: R/W

If this property is set to true, it will allow calculations to be performed. If set to false, this
property prevents all calculations from happening. Its default value is true.

fullscreen
Type: Boolean Access: R/W
This property puts the Acrobat viewer in fullscreen mode vs. regular viewing mode.

Example:

// on nouse up, set to fullscreen node
app. full screen = true;

In the above example, the Adobe Acrobat viewer is set to fullscreen mode when app.fullscreen
is set to true. If app.fullscreen was false then default viewing mode would be set. The default
viewing mode is defined as the original mode the Acrobat application was in before full
screen mode was initiated.

toolbar

Type: Boolean Access: R/W

This property allows a script to show or hide the Acrobat tool bar. It does not hide the tool
bar in External windows (i.e. in an Acrobat window within a Web browser). By default
toolbar is set to true. To remove the toolbar set the toolbar property to false.

Example:

// Qpened the document, now renpve the tool bar.
app. tool bar = fal se;
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language

. It returns the following

Type: String Access: R
Th_is property defines the language of the running Acrobat Viewer
strings:
String | Language, Country
DEU German, Germany
ENU English, The United States of America
ESP Spanish, Spain
FRA French, France
ITA Italian, Italy
JPN Japanese, Japan
NLD Dutch, The Netherlands
SVE Swedish, Sweden
viewerType
Type: String Access: R

This property determines if the running Acrobat Viewer is the Reader vs. Exchange. Its value
is “Reader” or “Exchange” respectively.

App Object Methods

alert

Parameters: cMessage, [nlcon], [nType]

Returns: nButton
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This method displays an alert dialog on the screen. The minimum required parameter is a
string containing the message to be displayed. Optionally, an icon type can be specified by

using the nlcon parameter. The following is a list of icons and their associated values:

Icon Value
Error (default) 0
Warning 1
Question 2
Status 3
Additionally, a button group type can be specified:
Button Group Value
OK (default) 0
OK, Cancel 1
Yes, No 2
Yes, No, Cancel 3

This method returns the type of the button that was

pressed by the user:

Button Type Value
Error 0
OK 1
Cancel 2
No 3
Yes 4

beep

Parameters: [nType]
Returns: none
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This method causes the system to play a sound. The various sounds and the values used are as
follows:

Message Type Value
Error (default) 0
Warning 1
Question 2
Status 3
Default 4

On Apple Macintosh and UNIX systems the beep type is ignored.

goBack

Parameters: None
Returns: nothing

Use this function to go to the previous view on the view stack. This is equivalent to pressing
the go back button on the Acrobat tool bar.

goForward

Parameters: None
Returns: nothing

Use this function to go to the next view on the view stack. This is equivalent to pressing the
go forward button on the Acrobat tool bar.

response

Parameters: cQuestion [cTitle], [cOldValue]
Returns: cResponse or null on cancel

This method displays a dialog box containing a question and an entry field for the user to
reply to the question. Optionally, the dialog may have a title or a default value for the answer
to the question. The return value is a string containing the user’s response. If the user presses
the cancel button on the dialog the response is the null object.
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Console Object

The Console object is a static object to access the JavaScript console for displaying debug
messages. It functions only within Acrobat Exchange.

Console Methods

show

Parameters: none
Returns: none

This method shows the console window.

close

Parameters: none
Returns: none

This method closes the console window.

println

Parameters: cMessage
Returns: none

This method prints the string value of cMessage to the console window with an accompanying
carriage return.

Example:

// This exanple prints the value of a field to the consol e wi ndow
var f = event. target;
console.println("Field value = " + f.val ue);

clear

Parameters: none
Returns: nothing

This method clears the console windows buffer of any output.
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Global Object

The Global object is a static JavaScript object that allows you to share data between documents
and have data be persistent across sessions. This is referred to as persistent global data.

Global data can be specified by adding properties to the global object. The property type can be
a string, a boolean, or a number. For example, to add a variable called “volume” and to allow
all document scripts to have access to this variable, a script would simply define it as:

gl obal . vol une = 80;

To delete a variable or a property from the global object, use the delete operator to remove the
defined property. For more information on the reserved JavaScript keyword delete, please see
Netscape’s JavaScript Reference Manual. For example, to remove the property “volume” from
the global object, call the following script:

del et e gl obal . vol une

Global Object Methods

setPersistent

parameters: string cVariable, boolean bPersist
Returns: none

This method sets cVariable to be persistent. It requires that bPersist is set true. This means the
cVariable will exist across invocations of Acrobat Exchange or Reader. If bPersist is false (the
default for any global property) then the property will be accessible across documents but not
across the Acrobat Viewer sessions. For example, to make the “volume” property persistent
and accessible for other documents you could use:

gl obal . set Persi stent ("vol une”, true);

Note: Persistent global data only applies to variables of type boolean, number or
string. For all persistent data there is a 32k limit for the maximum size of the
global persistent variables. Any data added to the string after the 32k limit will
be dropped.

Persistent Global Data - Naming Conventions

It is recommended that JavaScript developers building scripts for Acrobat Forms, utilize some
type of naming convention when specifying persistent global variables. One suggestion is to

Acrobat Forms - JavaScript Object Specification 36



start all variables with your company name. For example, if your company name is Xyz, start all
variables with “xyz_”. This will prevent collisions with other persistent global variable names
throughout the documents.
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Doc Object

The JavaScript Doc object provides the interfaces between a PDF document open in the viewer
and the JavaScript interpreter. It provides methods and properties of the PDF document.

Doc Access from JavaScript

Accessing the Doc object from JavaScript can be done either through the "this" Object,which
always points to the Doc object of the underlying document or through the target property of
the event object. The target event property points to the field that initiated the event for all
mouse, calculate, validate, and format events. For all other events, it directly points to the Doc
object. The examples below illustrates the use of the Event object to access the Doc object of
the underlying document.

// I'n Mbuse, calcul ate, validate, format events
var doc = event. target. doc;

// In all other events
var doc = event.target;

Doc Object Properties

author

Type: String Access: R/W

This property defines the author of the document.

this.author = “Robert Frost”;

creator

Type: String Access: R

This property defines the creator of the document like (i.e. “Adobe FrameMaker”, “Adobe
PageMaker”, etc.).

creationDate

Type: Date Access: R

This property defines the documents creation date.
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dirty
Type: Boolean Access: R/W

This property identifies whether the document has been dirtied as the result of a changes to
the document (and therefore needs to be saved). It is useful to reset the dirty flag in a docu-
ment when performing changes that do not warrant saving, for example, updating a status
field in the document.

var f this.getField("Status");
var b = this.dirty;
f.value = "Press the reset button to clear the form";
if (!b)
this.dirty = fal se;

filesize

Type: Integer Access: R

This property determines the file size of the document in bytes.

keywords
Type: String Access: R/W

This property specifies the document’s keywords in the Adobe Acrobat File-> Document Info-
> General dialog box.

modDate

Type: Date Access: R

This property contains the date the document was last modified.

numPages

Type: Integer Access: R

This property contains the number of pages in the document.

numTemplates

Type: Integer Access: R
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This property returns the number of templates in the document (see also getNthTemplate
and spawnPageFromTemplate methods).

path
Type: String Access: R

This property defines the device independent path of the document, for example /Acrobat3/
Exchange/doc.pdf

pageNum
Type: Integer Access: R/W

Use this property to get or set a page of the document. When setting the pageNum to a
specific page, remember that the values are “0” based.

// This exanple will got to the first page of the docunent.
this. pageNum = 0 ;

Or pageNum can be used to advance “n” pages in the document:

// This exanple will advance the docunent to the next page
t hi s. pageNum-+;

producer

Type: String Access: R

This property contains producer of the document (e.g. “Acrobat Distiller”, “PDFWriter”,
etc.).

subject

Type: String Access: R/W

This property defines the document’s subject.

title
Type: String Access: R/W

This property specifies the document’s title
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Z00m

Type: Integer Access: R/W

Use this property it to get or set the current page zoom level. The values allowed are 12% and
800% specified as an integer.

Example:

// This exanple will zoomin to twice the current zoom | evel.
this.zoom *= 2;

// This now sets the zoomto 200%
this. zoom = 200;

zoomType

Type: String Access: R/W

This property specifies the current zoom type of the document. Valid zoom types are: none,
fit page, fit width, fit height, and fit visible width. Again a convenience zoomType object that
defines all the valid zoom types is provided for use from JavaScript. It provides the following
zoom types:

Zoom Type Keyword
NoVary zoomtype.none
FitPage zoomtype fitP
Fitwidth zoomtype fitw
FitHeight zoomtype fitH
FitVisibleWidth zoomtype fitV

Example:

// This exanple sets the zoomtype of the docunent to fit the w dth.
this. zooniType = zoontype. fitW

Doc Object Methods

calculateNow

Parameters: none
Returns: nothing
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Use this function to force computation of all calculation fields in the current document.

getField

Parameters: cName
Returns: object

Use this function to map a field object in the PDF document to a JavaScript variable. The
cName parameter is the name of the field of interest. This function returns a Field JavaScript
object representing the form field in the PDF document.

getNthTemplate

Parameters: nWhich
Returns: cName

Use this function to retrieve the name of a template within in the document. (See also the
numTemplates property and spawnPageFromTemplate method.)

gotoNamedDest

Parameters: cName
Returns: nothing

Use this function to go to a named destination within the PDF document. For more details
on named destinations and how to create them, see the PDF Reference Manual Version 1.2

print

Parameters: binteractive, [nFirstPage], [nLastPage], [bSilent]
Returns: nothing

Use this function to print all or a specific number of pages of the document. If binteractive is
true, Acrobat displays the standard print dialog and all other parameters are ignored. The
optional nFirstPage and nLastPage parameters specify the range of pages to print. If using
nFirstPage and nLastPage parameters binteractive must be false. Set the optional bSilent flag to
true if you don’t want to display the cancel dialog box while the document is printing. The
default value for bSilent flag is false.

Example:

// This Exanple will print current page the docunent is on
this.print(false, this.page, this.page);
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resetForm

Parameters: [cFields]
Returns: nothing

Use this method to reset the field values within a document. If the cFields parameter is
present, then only the fields indicated are reset, otherwise all fields in the form are reset. You
can include non-terminal fields in the array. Use this as a simple shortcut for having a whole
subtree reset. For example, if you pass “name” as part of the fields array then “name.first”,
“name.last”, etc. will be reset.

var fields = new Array(2);

fields[O] "P1. Order Form Description”;
fields[1] = "P1. OrderForm Qy";
this.resetForn(fields);

scroll

Parameters: xOrigin: the x-coordinate to scroll to. yOrigin: the y-coordinate to scroll to.
Returns: nothing

Use this function to scroll the current page to the location specified by xOrigin and yOrigin.
These coordinates must be defined in user space. Please refer to the PDF Reference Manual
Version 1.2 for more details on the user space coordinate system.

spawnPageFromTemplate

Parameters: cTemplate, [iPage], [bPRename]
Returns: nothing

Use this function with a template name, such as the ones returned by getNthTemplate. The
optional parameter iPage, represents the page number (zero-based) into which the template
will be spawned. If that page already exists, then the template contents are appended to that
page. If ipage is omitted, a new page is created at the end of the document. The optional
parameter bRename, is boolean that indicates whether fields should be renamed. The default

for bRename is true.

Example:

var n = this. nunifenpl at es;
var cTenpl;
for (i =0; i <n; i++) {
cTenpl = this.getNthTenplate(i);
t hi s. spawnPageFr oniTenpl at e(cTenpl ) ;
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submitForm

Parameters: cCURL, [bFDF], [bEmpty], [fields]
Returns: nothing

Use this parameter to submit the form to a specific URL. The first parameter, cURL, is the
URL to submit to. This string must end in “#FDF” if the result from the submission is FDF.

The optional bFDF parameter is a boolean that indicates to submit as FDF or HTML If set
true, the default, it submits the form data as FDF. If false, it submits it as HTML.

The optional bEmpty parameter is a boolean that indicates, when true, that all fields are
submitted, including those that have no value, and if false to exclude those that currently
have no value. The default for bEmpty is false.

The optional fields parameter is the array of field names to submit. If this parameter is
present, then only the fields indicated are submitted, except those excluded by parameter
bEmpty. If this parameter is omitted, then all fields in the Form are submitted. This is used as
a simple shortcut for having a whole subtree submitted. You can include non-terminal fields
in the array.

Example:

/* submit the formto the server */
this.submtForm("http://nyserver/cgi-bin/nyscript.cgi #FDF");
oR
this.submitForm(“http://myserver/cgi-bin/myscript.cgi#FDF”,
TRUE, “name”);

The example above illustrates a shortcut to submitting a whole subtree. Passing “name” as part

of the field parameter, submits “name.title”, “name.first”, “name.middle” and “name.last”.
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this" Object
In JavaScript the special keyword “this” refers to the current object. In Acrobat Forms the
current object is defined as follows:

* In a method, it is the object to which the method belongs.

* In a constructor function, it is the object being constructed.

* In a top-level script, such as in format, validate, calculate, and perform scripts it is the
document object and therefore can be used to set or get doc properties and functions.

Example:

this. page /* returns the docunents current page number. */
this.print(true); /* prints the docunment interactively. */

Acrobat Forms - JavaScript Object Specification 45



Util Object

The Util Object is a static JavaScript object that defines a number of utility methods and
convenience functions for string and date formatting.

Util Object Methods

printf

Parameters: cFormat
Returns: cResult

This method will format one or more values as a string according to a format string. This is
similar to the C function of the same name.

printx

Parameters: cMask, ...
Returns: cResult

This method formats a source string according to a masking string. Valid masking values are
as follows:

Value Effect

? Copy next character.

X Copy next alphanumeric character, skipping any others.
A Copy next alpha character, skipping any others.

9 Copy next numeric character, skipping any others.

*

Copy the rest of the source string from this point on.

\ Escape character.
> Uppercase translation until further notice.
< Lowercase translation until further notice.

= Preserve case until further notice (default).

To format a string as a U.S. telephone number, for example, use the following script:

var v = "aaal4159697489zzz";
v = util.printx("9 (999) 999-9999", v);
console.println(v);
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printd

Parameters: cFormat, date

Returns: cResult

Use this method to format a date according to a format string. Valid string format values are

as follows:
String Effect Example
mmmm Long month September
mmm Abbreviated month Sept
mm Numeric month with leading zero 09
m Numeric month without leading zero 9
dddd Long day Wednesday
ddd Abbreviated day Wed
dd Numeric date with leading zero 03
d Numeric date without leading zero 3
yyyy Long year 1997
yy Abbreviate Year 97
HH 24 hour time with leading zero 09
H 24 hour time without leading zero 9
hh 12 hour time with leading zero 09
h 12 hour time without leading zero 9
MM minutes with leading zero 08
M minutes without leading zero 8
SS seconds with leading zero 05
S seconds without leading zero 5
tt am/pm indication am
t single digit am/pm indication a
\ use as an escape character

To format the current date in long format, for example, you would use the following script:
var d = new Date();
consol e.println(util.printd("mmmdd, yyyy",

d);
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